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SICHERHEITSHINWEISE Lesen Sie diese einfachen Richtlinien. Eine 
Nichtbeachtung dieser Regeln kann gefährliche Folgen haben oder gegen 
Vorschriften verstoßen. Weiterführende Informationen hierzu finden Sie 
im mitgelieferten Benutzerhandbuch.

VERKEHRSSICHERHEIT GEHT VOR Benutzen Sie den Communicator 
nicht während der Fahrt; parken Sie zuerst das Fahrzeug.

INTERFERENZEN Bei allen Mobiltelefonen kann es zu Interferenzen 
kommen, die die Leistung beeinträchtigen könnten.

IN KRANKENHÄUSERN AUSSCHALTEN Befolgen Sie alle Vorschriften 
und Regeln. Schalten Sie das Gerät in der Nähe medizinischer Geräte aus.

AN BORD EINES FLUGZEUGS AUSSCHALTEN Mobiltelefone können 
Interferenzen verursachen. Ihre Verwendung an Bord eines Flugzeugs ist 
verboten.

AN TANKSTELLEN AUSSCHALTEN Benutzen Sie das Telefon nicht an 
Tankstellen. Verwenden Sie es nicht in der Nähe von Kraftstoff oder 
Chemikalien.

IN SPRENGGEBIETEN AUSSCHALTEN Benutzen Sie das Telefon nicht in 
Sprenggebieten. Beachten Sie die Einschränkungen, und befolgen Sie die 
Vorschriften und Regeln.

UMSICHTIG VERWENDEN Halten Sie das Gerät nur in normaler Position 
(am Ohr). Berühren Sie die Antenne nicht unnötig.
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QUALIFIZIERTEN KUNDENDIENST IN ANSPRUCH NEHMEN Nur 
qualifiziertes Kundendienstpersonal darf das Gerät installieren und 
reparieren.

ZUBEHÖR UND AKKUS Verwenden Sie nur zugelassenes Zubehör und 
zugelassene Akkus. Schließen Sie keine vom Hersteller nicht zugelassenen 
Produkte an.

ANRUFE ÜBER DIE TELEFONSCHNITTSTELLE TÄTIGEN Stellen Sie 
sicher, daß das Telefon eingeschaltet und betriebsbereit ist. Geben Sie die 
Telefonnummer mit Vorwahl ein, und drücken Sie anschließend die Taste 

. Das Gespräch beenden Sie durch Drücken der Taste . Einen 
Anruf nehmen Sie durch Drücken der Taste  entgegen.

NOTRUFE Schließen Sie das Gerät. Stellen Sie sicher, daß die 
Telefonschnittstelle eingeschaltet und betriebsbereit ist. Halten Sie die 
Taste  einige Sekunden lang gedrückt, um die Anzeige zu löschen. 
Geben Sie die Notrufnummer ein, und drücken Sie anschließend die Taste 

. Geben Sie Ihren Standort durch. Beenden Sie das Gespräch erst, 
nachdem Sie dazu aufgefordert wurden.

SICHERUNGSKOPIEN ERSTELLEN Denken Sie daran, von allen 
wichtigen Daten Sicherungskopien zu erstellen.

AN ANDERE GERÄTE ANSCHLIESSEN Wenn Sie das Gerät an ein 
anderes anschließen, lesen Sie die Sicherheitshinweise in der 
Bedienungsanleitung für dieses Gerät. Schließen Sie keine nicht 
zugelassenen Produkte an.
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VORSICHTSMASSNAHMEN BEI INFRAROT Richten Sie den Infrarot-
Strahl nicht auf die Augen eines Menschen, und verhindern Sie, daß der 
Infrarot-Strahl Störungen bei anderen Infrarot-Geräten verursacht.



©2001 Nokia Mobile Phones. All rights reserved.

7

So
ft

w
ar

e 
au

f 
de

r 
CD

-R
O

M1. Software auf der CD-
ROM

Tipp: Informationen zum 
Installieren der Software 
finden Sie im 
Benutzerhandbuch.

Dieses Handbuch enthält Informationen über die Software, die Sie von der im 
Lieferumfang enthaltenen CD-ROM installieren können. Diese Anwendungen 
finden Sie in den Abschnitten „Software für den Communicator“ und „Sofware für 
PC“. Beachten Sie, dass einige der Add-On-Anwendungen in separaten 
Handbüchern erläutert werden. Diese finden Sie neben den jeweiligen 
Programmen auf der CD-ROM.

So installieren Sie Software von 
der CD-ROM:
Die auf der CD-ROM des Communicators enthaltenen Anwendungen und Dateien 
können auf dem Communicator installiert werden. Führen Sie die Installation 
folgendermaßen aus:
1 Stellen Sie sicher, dass Sie die PC Suite auf dem Computer installiert haben. 

Die PC Suite befindet sich auf der im Lieferumfang enthaltenen CD-ROM.
2 Legen Sie die CD-ROM in das CD-ROM-Laufwerk des Computers ein.
3 Sie haben folgende Möglichkeiten: Schließen Sie den Communicator mit dem 

im Lieferumfang enthaltenen Adapterkabel an den Computer an. 
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vor. Weitere Informationen finden Sie im Benutzerhandbuch.
4 Die CD-ROM startet automatisch. Sollte dies nicht der Fall sein, doppelklicken 

Sie in der Dateistruktur der CD-ROM auf die Datei „Nokia9210.exe“.
Tipp: Verwenden Sie 

die Mini-Speicherkarte 
für den Communicator, 
um den Speicherplatz für 
die verschiedenen 
Anwendungen auf der 
CD-ROM zu vergrößern.

5 Wählen Sie das zu installierende Programm auf der CD-ROM aus, und klicken 
Sie auf „Installieren“
Hinweis: Installieren Sie Add-On-Anwendungen immer in der Sprache Ihres 

Communicators.

Remote-Synchronisation
Mit Hilfe der Anwendung „Remote-Synchronisation“ für den Nokia 9210 
Communicator können Sie den Kalender und die Kontakte über einen GSM-
Datenanruf mit verschiedenen Internet-Kalendern und -Adressbüchern sowie mit 
vielen Unternehmenslösungen wie Lotus Notes synchronisieren. Die Anwendung 
verwendet für die Synchronisation die SyncML-Technologie.

Remote-Servereinstellungen werden als „Synchronisationsprofile“ bezeichnet. Sie 
können gegebenenfalls verschiedene Profile eingeben, wenn die Synchronisation 
mit mehreren Servern oder Anwendungen erfolgen soll.

Hinweis: Informationen über SyncML-Kompatibilität erhalten Sie von Ihrem 
Diensteanbieter oder vom Helpdesk des Unternehmens.

Hinweis: Dieses Produkt enthält Software, die von der SyncML-Initiative 
entwickelt wurde.
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Wenn Sie die Remote-Synchronisation starten, wird das aktuelle 
Synchronisationsprofil in der Hauptansicht unter dem Titel Remote-
Synchronisation angezeigt. Wenn kein Profil erstellt wurde, wird der Text <keine 
Profile definiert> angezeigt. 

So erstellen Sie ein neues Profil:

Abbildung 1

Tipp: Um ein neues Profil 
zu erstellen, das auf einem 
anderen Profil basiert, 
wählen Sie als Vorlage das 
Profil aus, das dem neuen 
Profil am ähnlichsten ist.

1 Wenn keine Profile festgelegt wurden, drücken Sie auf Neu. Ein Dialogfeld wird 
geöffnet. Fahren Sie mit Schritt 4 fort.

2 Wenn mindestens ein Profil festgelegt wurde, drücken Sie in der Hauptansicht 
auf Profileinstellungen, um die verfügbaren Profile anzuzeigen. 

3 Um ein vorhandenes Profil als Vorlage für ein neues Profil zu verwenden, 
wählen Sie das gewünschte Vorlagenprofil aus und klicken auf Neu. 
Ein Dialogfeld wird geöffnet.

4 Legen Sie Folgendes fest:
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Tipp: Wählen Sie das am 
häufigsten verwendete 
Profil als Standardprofil aus.

Standardprofil: Es muss mindestens eines der verfügbaren Synchronisationsprofile 
als Standardprofil definiert sein. Um dieses Profil als Standard zu 
definieren, wählen Sie Ja. Um den Zugriff auf das Standardprofil zu 
erleichtern, wird dieses in der Hauptansicht angezeigt.

Profilname: Geben Sie einen beschreibenden Namen für das Profil ein. 
Beispiel: „Mein Office-Kalender“. Jedes Profil muss einen eindeutigen 
Namen haben.

Internetzugang/Internetzugang/Host-Adresse/Anschluss/HTTP-Authentifizierung: Die 
korrekten Einstellungen erfahren Sie von Ihrem Diensteanbieter 
oder Systemadministrator.

Benutzername: Ihre Benutzer-ID für den Synchronisationsserver. Die korrekte ID 
erfahren Sie von Ihrem Diensteanbieter oder Systemadministrator.

Kennwort: Geben Sie Ihr Passwort hier ein. Aus Sicherheitsgründen wird das 
Passwort auf dem Display durch Sternchen (*****) verschlüsselt. 
Das korrekte Passwort erfahren Sie von Ihrem Diensteanbieter 
oder Systemadministrator.

Hinweis: Die Einstellungen können nur für das Feld HTTP-Authentifizierung 
geändert werden.



©2001 Nokia Mobile Phones. All rights reserved.

11

So
ft

w
ar

e 
au

f 
de

r 
CD

-R
O

MDie Registerkarte „Daten“

Abbildung 2

Sie können auf dieser Registerkarte festlegen, welche Daten mit einem Server 
synchronisiert werden sollen. 
1 Wählen Sie die Anwendung mit den Pfeiltasten aus, und klicken Sie auf Ändern, 

um die Option Ja oder Nein auszuwählen.
2 Um die Kalender- oder Kontakteinstellungen festzulegen, drücken Sie auf 

Einstellungen. Ein Dialogfeld wird geöffnet. Legen Sie folgende Einstellungen 
fest:
Kalenderdatei/Kontaktdatei: Drücken Sie auf Durchsuchen, um die richtige 
Datenbank auf Ihrem Communicator auszuwählen.
Remote-Kalender/Remote-Kontakte: Weitere Informationen erhalten Sie von 
Ihrem Diensteanbieter oder Systemadministrator.
Hinweis: Bevor Sie die Kalenderdaten synchronisieren können, muss die 

Kalenderdatei auf Ihrem Communicator abgelegt sein. Verwenden Sie 
die Anwendung „Kalender“, um eine Kalenderdatei zu erstellen.
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1 Stellen Sie in der Hauptansicht sicher, das das richtige Profil ausgewählt ist. 
Drücken Sie auf Sync. Der Fortschritt der Synchronisation wird unten im 
Fenster angezeigt.

2 Um die Synchronisation vorzeitig abzubrechen, drücken Sie auf Abbrechen. 
3 Sie werden benachrichtigt, sobald die Synchronisation ausgeführt wurde. 

Drücken Sie auf Protokoll anzeigen, um eine Protokolldatei anzuzeigen, oder 
auf Schließen, um zur Hauptansicht zurückzukehren.

So bearbeiten Sie vorhandene Serverprofile:
1 Drücken Sie in der Hauptansicht auf Profileinstellungen. Eine Liste der 

Serverprofile wird angezeigt.
2 Wählen Sie das zu bearbeitende Profil mit den Pfeiltasten aus, und drücken Sie 

auf Bearbeiten.
3 Bearbeiten Sie das Profil wunschgemäß. Die korrekten Werte erfahren Sie von 

Ihrem Diensteanbieter oder Systemadministrator. Weitere Informationen zu 
den Einstellungen finden Sie unter „Die Registerkarte „Allgemein““ auf Seite 10 
und unter „Die Registerkarte „Daten““ auf Seite 11.

4 Klicken Sie auf Schließen, um die Änderungen zu übernehmen und das 
Dialogfeld zu schließen.

So löschen Sie vorhandene Serverprofile:
1 Drücken Sie in der Hauptansicht auf Profileinstellungen. Eine Liste der 

Serverprofile wird angezeigt.
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Löschen.

So führen Sie eine Synchronisation mit einem 
anderen Server durch:
1 Drücken Sie in der Hauptansicht auf Profilsynchronisation. Eine Liste der 

Serverprofile wird angezeigt.
2 Wählen Sie ein Profil aus, und drücken Sie auf Sync.

So zeigen Sie Synchronisationsprotokolle an:
Sie können das letzte Synchronisationsprotokoll des Profils anzeigen. 
1 Drücken Sie in der Hauptansicht auf Profilsynchronisation. Eine Liste der 

Serverprofile wird angezeigt.
2 Wählen Sie ein Profil aus, und drücken Sie auf Protokoll anzeigen. Im Protokoll 

wird die Anzahl der aktualisierten, hinzugefügten oder gelöschten Elemente 
angegeben.

Umrechnen von Einheiten
Mit der Anwendung „Einheiten umrechnen“ für den Nokia 9210 Communicator 
können Sie Maßeinheiten und Währungen umrechnen.
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Abbildung 3

Um dieses Tool zu öffnen, wählen Sie die Konvertierungskategorie in der 
Hauptansicht und drücken auf Öffnen.

Folgende Konvertierungskategorien und Einheiten stehen zur Auswahl:

Konvertierungskategorie Einheit A Einheit B

Währung USD EUR

Bereich ft2 m2

Energie kcal kJ

Länge mi km

Masse lbs kg

Kraft PS kW

Druck Pa bar

Temperatur F C

Zeit d h

Geschwindigkeit mph km/h
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Das Konvertierungstool für eine bestimmte Konvertierungskategorie enthält zwei 
Fensterbereiche (siehe Abbildung 3).

Tipp: Mit der 
Tabulatortaste können 
Sie zwischen den 
Fensterbereichen wechseln.

Es kann jeweils nur ein Fensterbereich aktiv sein. Die Fensterbereiche haben immer 
entsprechende Werte. Wenn sich der Wert in einem der beiden Fensterbereiche 
ändert, wird der andere Fensterbereich automatisch aktualisiert.

Hinweis: Der Rechner hat eine begrenzte Genauigkeit, so dass Rundungsfehler 
auftreten können.

So ändern Sie Einheiten:
Sie können die in einer bestimmten Konvertierungskategorie verwendeten 
Einheiten ändern. Beispielsweise können in der Währungskategorie anstelle von 
US-Dollar französische Francs als Ausgangswährung festgelegt werden.
1 Drücken Sie in der Ansicht des Konvertierungstools für die bestimmte 

Konvertierungskategorie auf Einheit ändern. Ein Dialogfeld wird geöffnet.
2 Wählen Sie ein Element aus der Liste aus, oder durchsuchen Sie die Liste, 

indem Sie eine Zeichenfolge in das Suchfeld eingeben.
3 Drücken Sie auf Auswählen, um die Änderung zu bestätigen, oder auf 

Abbrechen, um die Änderung rückgängig zu machen.

So fügen Sie Währungseinheiten hinzu und 
bearbeiten diese:

Hinweis: Es können nur Währungseinheiten bearbeitet, gelöscht und 
hinzugefügt werden.

Volumen gal (US) Liter
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zu löschen, wählen Sie 
diese aus und drücken 
anschließend die 
Menütaste. Wählen Sie 
anschließend Datei > 
Währung löschen…. 
Drücken Sie auf Löschen.

1 Öffnen Sie die ausgewählte Währungskategorie.
2 Um eine Währung zu bearbeiten, wählen Sie diese aus und drücken auf Öffnen.

Um eine Währung hinzuzufügen, drücken Sie die Menütaste und wählen Datei 
> Neue Währung….
Ein Dialogfeld wird geöffnet.

3 Legen Sie folgende Einstellungen fest:
Name: Name der Währungseinheit.
Symbol: Abkürzung für die Währungseinheit.

4 Drücken Sie auf Wechselkurs berechnen, um Folgendes zu definieren:
Wechselkurs: Die durch die Basiseinheit definierte Konvertierungsrate.
Ein Dialogfeld wird geöffnet.

5 Definieren Sie die Werte für die Einheiten der neuen Währung und der 
Basiswährung, und drücken Sie auf Abbrechen.

6 Drücken Sie auf Schließen, um die Änderungen zu bestätigen.

Dateiansicht
In der Dateiansicht können Sie verschiedene Text-, Grafik- und andere 
Dateiformate anzeigen. Außerdem können Sie archivierte Dateien öffnen 
und extrahieren.
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Abbildung 4

Unterstützte Formate:
Die CD-ROM enthält fünf Installationsdateien, die verschiedene Arten von 
Dateiformaten unterstützen. Die folgende Liste enthält die verfügbaren 
Installationsdateien sowie unterstützte Dateiformate.

Installationsdatei Unterstützte Dateiformate Unterstützte Dateierweiterungen

Alle Installationsdateien

Einfacher Text TXT

Windows-Bitmap BMP, RLE, ICO, CUR

Portable Network Graphics PNG

Windows-Metadatei WMF, EMF

MS_Powerpoint.sis Microsoft Powerpoint 3/4/7/97/
98/2000 PPT, POT, PPS

MS_Excel.sis Microsoft Excel 2/3/4/5/7/97/98/
2000 XLS, XLC
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MS_Office.sis

Microsoft Powerpoint 3/4/7/97/
98/2000 PPT, POT, PPS

Microsoft Excel 2/3/4/5/7/97/98/
2000 XLS, XLC

Microsoft Excel 2/1/4/5/7/97/98/
2000 DOC, WRI

Lotus_WP_AMI.sis

Lotus 1-2-3 v. 1/2/3/4/5/97/Mille-
nium

WQ1, WKU, WK1, WK3, WK4, 
WK5, WK6, 123

Lotus Ami Pro SAM

WordPerfect 4/5/6/7/8 WPD

WordPerfect Graphic WPG

Lotus Ami Draw SDW

Other.sis: Bildformate

Computer Graphics Metadatei CGM

Compuserve GIF GIF

Paintbrush PCX, DCX

Tagged Image File Format TIF, JPG, JIF

Other.sis: Textformate

Internet Hypertext Markup Lan-
guage HTML

Einfacher Text TXT

vCard VCF

Rich Text Format RTF
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So zeigen Sie Dateien an:
Hinweis: Die verfügbaren Menüoptionen und Befehle hängen vom jeweils 

angezeigten Dateityp ab.

1 Wählen Sie in der Liste der unter „Extras“ verfügbaren Anwendungen die Option 
Dateiansicht, und drücken Sie die Eingabetaste.

2 Das Dialogfeld „Öffnen“ wird eingeblendet.
3 Drücken Sie auf Durchsuchen, um nach einer unterstützten Datei zu suchen, 

und drücken Sie auf OK. Die Datei wird geöffnet. Je nach Dateityp stehen Ihnen 
folgende Optionen zur Verfügung:

Alle Dateien
• Drücken Sie auf Vergrößern und Verkleinern, um die Ansicht zu ändern. 
• Drücken Sie die Menütaste, und wählen Sie die Option Ansicht > Vollbild-Modus, 

um nur den Inhalt des Dokuments oder der Datei auf dem Display anzuzeigen.
• Um die Datei zu versenden, drücken Sie auf Senden. Das Dialogfeld „Senden“ 

wird geöffnet. Folgende Optionen sind verfügbar: Als E-Mail/Über Infrarot. 
Drücken Sie auf Senden, um den Vorgang zu bestätigen.

• Um die Dateiansicht zu schließen, drücken Sie auf Schließen.

Other.sis: Archivierte Dateien

Winzip, PKZIP ZIP, EXE

Unix Gzip TGZ

Unix Compress TAR, TAZ

Other.sis: Andere Formate
Microsoft Project MPP

Visio VSD
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• Drücken Sie die Menütaste, und wählen Sie Bild/Dokument> Breite anpassen, 
um den Zoomfaktor für die Datei zu ändern und die Datei an die Breite des 
Displays anzupassen.

• Wählen Sie Bild/Dokument > An Fenster anpassen, um den Zoomfaktor für die 
Datei zu ändern und die Datei an die Breite des Displays anzupassen.

Textdokumente und Arbeitsblätter
Das Menü Dokument oder Arbeitsblatt enthält verschiedene Anzeigeoptionen.
• Entwurfansicht: Um die Entwurfsansicht auszuwählen, drücken Sie die 

Menütaste und wählen Dokument > Entwurfansicht oder Arbeitsblatt > 
Entwurfansicht. In der Entwurfsansicht wird der Text des Dokuments oder der 
Tabelle in einer einzigen Schriftart angezeigt. Zeichenformatierung, 
Absatzausrichtung, Abstände und Tabulatoreinzüge werden ebenfalls 
angezeigt. Eingebettete Objekte werden in der Entwurfsansicht nicht 
angezeigt. 

• Ansicht "Normal": Um die normale Ansicht auszuwählen, drücken Sie die 
Menütaste, und wählen Sie Dokument > Ansicht "Normal" oder Arbeitsblatt > 
Ansicht "Normal". In der normalen Ansicht werden alle Schriftarten und 
eingebetteten Objekte wie im Originaldokument angezeigt.

Tipp: Beim Anzeigen 
eines Textdokuments 
können Sie Text markieren, 
kopieren und aus der 
Zwischenablage in 
anderen Anwendungen 
wieder einfügen.

• Seitenansicht: Um die Seitenansicht auszuwählen, drücken Sie die Menütaste 
und wählen Dokument > Seitenansicht oder Arbeitsblatt > Seitenansicht. In der 
Seitenansicht wird der Text des Dokuments oder der Tabelle so angezeigt wie 
im Originaldokument, einschließlich Zeilenumbrüchen, Spalten, Seitenrändern, 
Kopf- und Fußzeilen sowie Anmerkungen.
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• Drücken Sie die Menütaste, und wählen Sie Bild > Breite anpassen, um den 

Zoomfaktor für das Bild zu ändern und das Bild an die Breite des 
Displays anzupassen.

• Wählen Sie Bild > An Fenster anpassen, um den Zoomfaktor für das Bild zu 
ändern und das Bild an die Breite des Fensters anzupassen.

• Wählen Sie Bild > Drehen, um das Bild um 90 Grad im Uhrzeigersinn zu drehen.
• Wählen Sie Bild > Zurücksetzen, um alle Änderungen an dem Bild seit dem 

Öffnen zurückzusetzen.

Archivierte Dateien
• Um ausgewählte Dateien zu extrahieren, drücken Sie auf Extrahieren. 

Ein Dialogfeld zum Festlegen des Zielordners wird geöffnet.
• Um alle Dateien in einem Archiv zu extrahieren, drücken Sie auf Alle 

extrahieren.
• Um eine Archivdatei anzuzeigen, drücken Sie auf Ansicht.

Sie können die in einem Archiv enthaltenen Dateien auch sortieren. 
• Wählen Sie Bearbeiten > Sortieren nach, um bestimmte Kriterien für den 

Suchvorgang festzulegen. Folgende Optionen sind verfügbar: Name/Datum/
Größe.

• Wählen Sie Bearbeiten > Sortierreihenfolge, um die Sortierreihenfolge 
festzulegen. Folgende Optionen sind verfügbar: Aufsteigend/Absteigend.
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Tipp: 
Die Tastenkombinationen 
für die Befehle Nächste Folie 
bzw. Vorherige Folie lauten 
Umschalt+Strg+N und 
Umschalt+Strg+P.

Um Folien anzuzeigen, drücken Sie die Menütaste und wählen Folie > Nächste Folie/
Vorherige Folie. Die übrigen Befehle im MenüFolie entsprechen denen im Menü Bild.

So konfigurieren Sie Optionen für die 
Dateiansicht:
Drücken Sie die Menütaste und wählen Ansicht > Optionen…. Ein Dialogfeld mit 
zwei Registerkarten wird geöffnet. Legen Sie folgende Einstellungen fest:

Die Registerkarte „Ansicht“
Standardschriftart: Um die Standardschriftart auszuwählen, drücken Sie auf 

Ändern. Das Dialogfeld „Schriftart“ wird geöffnet.
Unbekannte Dateien anzeigen: Legt fest, wie unbekannte Dateitypen angezeigt 

werden. Folgende Optionen sind verfügbar: Als Text/Als Hexadezimal/Nicht 
anzeigen.

Nicht unterstützte Dateien anzeigen: Legt fest, wie nicht unterstützte Dateitypen 
angezeigt werden. Folgende Optionen sind verfügbar: Benutzer fragen/In 
registrierter Anwendung öffnen/Als unbekannten Dateityp.

Die Registerkarte „Andere“
Gitterlinien anzeigen : Wählen Sie die Standardeinstellungen für die Gitterlinien in 

einem Arbeitsblatt aus. Folgende Optionen sind verfügbar: Ja/Nein.
Archive sortieren nach : Legen Sie das Standardkriterium für das Sortieren von 

Archivdateien fest. Folgende Optionen sind verfügbar: 
Name/Datum/Type/Größe.
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Folgende Optionen sind verfügbar: Aufsteigend/Absteigend.

Um das Dialogfeld zu schließen, drücken Sie auf Schließen.

Notizen

Abbildung 5

Die Anwendung „Notizen“ ist ein einfacher Texteditor zum schnellen Eingeben 
kurzer Notizen und zum Erstellen von Listen. Sie haben die Möglichkeit, 
mehrere Notizen in einer Liste zusammenzufassen. Sie können diese Liste auf 
verschiedene Arten sortieren und als Notizblock speichern. Viele der 
Standardbefehle aus anderen Textverarbeitungsprogrammen sind auch in der 
Anwendung „Notizen“ verfügbar.

Notizen ist nur in Englisch verfügbar.

So erstellen und löschen Sie einzelne Notizen und 
Notizblöcke:
Um eine neue Notiz zu erstellen, drücken Sie auf New note. 
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Um einen neuen Notizblock hinzuzufügen, drücken Sie die Menütaste und wählen 
File > New file. Sie können mehrere Notizblöcke für verschiedene Themen erstellen.

Ansichten
Tipp: Die Notizansicht 

eignet sich zum Bearbeiten 
großer Textmengen. 
Die geteilte Ansicht eignet 
sich gut zum Durchsuchen 
von Notizblöcken.

Sie können nur den Inhalt einer Notiz oder eine Notiz und die gesamte Notizliste 
anzeigen. Um eine Ansicht auszuwählen, drücken Sie die Menütaste und wählen 
View > Split view/Note view.

Um in der geteilten Ansicht zwischen den Fenstern zu wechseln, drücken Sie auf 
Change Focus.

Um die aktuelle Ansicht im Vollbildmodus anzuzeigen, drücken Sie die Menütaste 
und wählen View > Full screen. Um wieder zur normalen Ansicht zurückzukehren, 
wählen Sie die Option Full screen.

So formatieren Sie den Text einer Notiz:
1 Wählen Sie den zu bearbeitenden Text aus.
2 Drücken Sie die Menütaste, und wählen Sie die gewünschten Optionen im 

Menü Format aus:
Wählen Sie die Option Font..., um die verwendete Schriftart zu ändern bzw. um 
festzulegen, ob der Text fett, kursiv, unterstrichen oder als Liste formatiert 
werden soll. 
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Tipp: Die Funktion 

zum Ermitteln der Wort- 
und Zeichenanzahl ist 
nützlich, wenn Sie eine 
Notiz als Kurzmitteilung 
versenden möchten, 
da Kurzmitteilungen nicht 
länger als ca. 160 Zeichen 
sein dürfen.

Drücken Sie die Menütaste, und wählen Sie Tools >Word count. 

So prüfen Sie die Rechtschreibung einer Notiz:
Wenn Sie die Anwendung „Rechtschreibprüfung“ installiert haben, können Sie eine 
Notiz folgendermaßen auf korrekte Rechtschreibung überprüfen:
1 Drücken Sie die Menütaste, und wählen Sie Tools > Spell check.
2 Um zusätzliche Vorschläge zu unbekannten Wörtern anzuzeigen, wählen Sie 

Vorschläge und anschließend Ändern.

So sortieren Sie Notizen:
Sie können die Notizen innerhalb eines Notizblocks folgendermaßen sortieren:
1 Drücken Sie die Menütaste, und wählen Sie Tools > Sort by . Geben Sie 

anschließend die gewünschten Suchkriterien an. Folgende Optionen sind 
verfügbar: Creation Date/Last Modified Date/Title. 

2 Um die gewünschte Sortierreihenfolge festzulegen, drücken Sie die Menütaste 
und wählen Tools > Sorting Order und anschließend Ascending oder Descending.

Voreinstellungen
Um die Voreinstellungen für Notizen anzuzeigen, drücken Sie die Menütaste und 
wählen Tools > Preferences. Ein Dialogfeld mit zwei Registerkarten wird geöffnet. 
Legen Sie folgende Einstellungen fest: 
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Show title of entries on – Legen Sie fest, ob die Listenansicht auf der linken oder auf 
der rechten Seite der geteilten Ansicht eingeblendet werden soll.

Note width – Legen Sie die Breite der Notizansicht in der geteilten Ansicht fest. 
Sie können eine Breite zwischen 10 und 80 % auswählen.

Display – Legen Sie fest, in welchem Datumsformat das Datum in der Statusleiste 
unten im Display angezeigt werden soll. Folgende Optionen sind verfügbar: 
Last update date /Creation date.

Voreinstellungen für Notizen
Mit der Option Always start on a new note legen Sie fest, ob automatisch neue 
Notizen erstellt werden sollen. Folgende Optionen sind verfügbar: No/Yes.

Mit der Option Include in list legen Sie fest, wie viel Text in der geteilten Ansicht in 
der Notizliste sichtbar sein soll. Folgende Optionen sind verfügbar: First line/All text. 
Wenn Sie die Option First line auswählen, wird nur die erste Zeile der Notiz 
angezeigt. Mit der Option All text wird festgelegt, dass so viel Text wie möglich 
angezeigt wird.

So drucken Sie Notizen:
Um eine Notiz zu drucken, drücken Sie die Menütaste und wählen File > 
Printing > Print.... 

Um das Seitenlayout festzulegen, drücken Sie die Menütaste und wählen File > 
Printing > Page setup... 

Um vor dem Ausdrucken eine Vorschau anzuzeigen, drücken Sie die Menütaste und 
wählen File > Printing > Print preview...
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Im Suchdialogfeld können Sie Zeichenfolgen in Notizen problemlos suchen 
und ersetzen. 
1 Drücken Sie die Menütaste, und wählen Sie Edit > Find.
2 Geben Sie die zu suchende Zeichenfolge ein. Drücken Sie auf Ersetzen, um die 

gesuchte Zeichenfolge durch den neuen Text zu ersetzen.
3 Drücken Sie auf Optionen, um die Suche einzugrenzen, indem Sie festlegen, 

dass Großbuchstaben berücksichtigt werden sollen oder nur nach ganzen 
Wörtern gesucht werden soll.

4 Drücken Sie auf Suchen. Es wird zuerst die aktuelle Notiz und anschließend der 
Rest der Notizen durchsucht.

5 Um das nächste Suchergebnis anzuzeigen, drücken Sie auf Weitersuchen.

Multimedia Converter
Tipp: NIM ist die 

Abkürzung für das 
Dateiformat „Nokia 
Interleaved Multimedia“.

Die Anwendung „Multimedia Converter“ ist eine PC-Anwendung. Mit dem 
Multimedia Converter können Sie viele Video-Dateiformate in das vom Nokia 9210 
Communicator unterstützte NIM-Format konvertieren. Sie können auch die 
meisten Audiodateiformate in das WAV-Format konvertieren und bestehende 
WAV-Dateien für die Verwendung mit dem Nokia 9210 Communicator optimieren. 
Sie können konvertierte WAV-Dateien beispielsweise als Ruftöne verwenden.
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Abbildung 6

Der Converter bietet Ihnen folgende Vorteile:
• Nach der Konvertierung haben Audio- oder Videodateien in der Regel eine 

wesentlich geringere Dateigröße. Deshalb ist die Wiedergabe auf dem 
Communicator weniger speicherintensiv und flüssiger. Viele Dateien können 
erst nach der Konvertierung auf dem Communicator wiedergegeben werden.

• WAV-Dateien werden auf Ihrem Communicator in einer besseren 
Tonqualität wiedergegeben.
Hinweis: Der Multimedia Converter unterstützt die meisten Dateiformate, 

die mit dem Windows Media Player abgespielt werden können. 
Die unterstützten Dateitypen hängen von der auf dem System 
installierten Media Player-Version und von den installierten Audio- 
und Video-Codecs ab. In der Regel unterstützt der Multimedia 
Converter die meisten Dateien im Format AVI, WAV, MPG und MP3.
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MSo optimieren Sie reine Audiodateien:
1 Wählen Sie im Menü File > Open. Ein Dialogfeld wird geöffnet.
2 Navigieren Sie zu der zu konvertierenden Audiodatei, und klicken Sie auf OK. 

Die Informationen über die Datei werden links neben dem Fenster in die Felder 
Original und file eingetragen. In den Feldern werden der Dateityp, die Dateigröße 
und die Wiedergabedauer angezeigt.

3 Wählen Sie eine der beiden Optionen im Feld Audio format aus: 
Low compression: Für die beste Tonqualität
Normal compression: Für eine etwas geringere Tonqualität bei einer wesentlich 
geringeren Dateigröße

4 Klicken Sie auf Convert. Die Informationen über die konvertierte Datei werden 
rechts neben dem Fenster in den Feldern Converted file eingetragen.

5 Wählen Sie File > Save as, um die neue Datei zu speichern.
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Tipp: Die Bildfrequenz 
gibt die Rate an, in der die 
einzelnen Bilder (Frames) 
der Sequenz, die den 
Bewegungsablauf 
simulieren, in einem Film 
oder einem Video angezeigt 
werden. Die Bildfrequenz 
wird in Frames pro Sekunde 
(fps) gemessen. Bei einer 
geringeren Bildfrequenz 
wird die Wiedergabe des 
Bewegungsablaufs 
beeinträchtigt.

1 Wählen Sie File > Open. Ein Dialogfeld wird geöffnet.
2 Navigieren Sie zu der Videodatei, die Sie konvertieren möchten, und klicken Sie 

auf OK. Die Informationen über die Datei werden links neben dem Fenster in die 
Felder Original und file eingetragen. In den Feldern werden der Dateityp, 
die Dateigröße und die Wiedergabedauer angezeigt.

3 Wählen Sie eine der beiden Optionen im Feld Video quality aus:
Smooth motion, small image size: Wählen Sie diese Option für die maximal 
erreichbare Bildfrequenz. 
Normal motion, normal image size : Für eine normale Bildgröße und einen leicht 
stockenden Bewegungsablauf.

4 Wenn die Datei Video- und Audioelemente enthält, wählen Sie im Feld Audio 
format eine der beiden Optionen:
Music, normal compression: Verwenden Sie diese Option, wenn die Quelldatei 
Melodien oder anderes Material enthält, das eine hohe Tonqualität erfordert.
Voice, high compression: Verwenden Sie diese Option, wenn die Originaldatei nur 
Sprachelemente enthält oder eine geringe Dateigröße wichtiger als die 
Tonqualität ist.

5 Klicken Sie auf Convert. Die Informationen über die konvertierte Datei werden 
rechts neben dem Fenster in den Feldern Converted file eingetragen.
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MTipp: Sie können die 
Originaldatei (vor der 
Konvertierung) und die 
konvertierte Datei abspielen. 
Verwenden Sie die 
Steuertasten unter den 
Vorschaufenstern, um die 
Wiedergabe zu starten, 
anzuhalten und zu beenden.

6 Wählen Sie im Menü File > Save as, um die neue Datei zu speichern.
Hinweis: Während der Konvertierung können keine Dateien abgespielt werden.

Sie können die konvertierte Datei mit der PC Suite für den Nokia 9210 
Communicator auf Ihren Communicator übertragen. Weitere Informationen hierzu 
finden Sie im Handbuch zur PC Suite, das sich auf der im Lieferumfang enthaltenen 
CD-ROM befindet.

Spiele
Tipp: Wenn Sie weitere 

Informationen zu Nokia 
Spielen erhalten möchten, 
werden Sie Mitglied bei Club 
Nokia. Informationen hierzu 
finden Sie unter 
www.club.nokia.com.

Der Communicator ist nicht nur ein effizientes Business Tool, sondern bietet Ihnen 
auch noch gute Unterhaltung in der Freizeit. In diesem Abschnitt finden Sie 
spannende Spiele für Ihren Nokia 9210 Communicator.

Installation
Stellen Sie eine Verbindung zwischen dem Nokia 9210 Communicator und dem PC 
her. Öffnen Sie die CD-ROM, wählen Sie das gewünschte Spiel aus dem Ordner 
„Software für den Communicator/Spiele“ aus, und drücken Sie auf Installieren.

Bounce
Bei Bounce navigieren Sie einen kleinen Ball durch eine feindliche Umwelt. Es gilt, 
den Ball durch die einzelnen Ebenen zu steuern und dabei Gefahren auszuweichen 
sowie genügend Ringe zum Betreten der nächsten Ebene zu sammeln. Verwenden 
Sie die Gummiblöcke, um höher zu springen und an die schwer erreichbaren Ringe 
zu gelangen. Eine ausführliche Anleitung ist im Spiel enthalten. Bounce ist nur in 
Englisch verfügbar.
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Abbildung 7

Anforderungen
Bounce benötigt mindestens 1,5 MB Arbeitsspeicher und 800 KB 
freien Speicherplatz auf dem Nokia 9210 Communicator bzw. auf 
der Mini-Speicherkarte.

So starten Sie Bounce:
1 Wählen Sie mit den Pfeiltasten das Symbol für Bounce aus der Liste „Extras“ 

aus, und drücken Sie auf Öffnen.
2 Wenn das animierte Logo von Bounce angezeigt wird, drücken Sie eine 

beliebige Taste, um das Hauptmenü zu aktivieren.
3 Wählen Sie das gewünschte Element mit den Pfeiltasten aus. Drücken Sie 

anschließend die Eingabetaste, um den Befehl auszuführen.

Hauptfenster
Das Menü des Hauptfensters enthält fünf Optionen: Start Game, Online, Options, 
High Scores und Quit. 

Um die Option Quit auszuwählen, drücken Sie die Pfeiltaste > und anschließend die 
Eingabetaste oder die unterste Befehlstaste.



©2001 Nokia Mobile Phones. All rights reserved.

33

So
ft

w
ar

e 
au

f 
de

r 
CD

-R
O

MSpielbeginn
Das Menü Start Game enthält vier Optionen: New Game, Continue, Instructions 
und Back. 

Mit der Option New Game startet ein neues Spiel der Schwierigkeitsstufe 1. 

Mit der Option Continue öffnen Sie das Menü „Weiter“.

Mit der Option Instructions wird eine automatische Demonstration der Funktionen 
des Spiels gestartet. 

Mit der Option Back rufen Sie das Hauptfenster auf.

Weiter
Das Menü Continue enthält vier Plätze für zuvor gespeicherte Spiele. Jeder Platz 
gibt die Nummer der Ebene des gespeicherten Spiels und die Anzahl der restlichen 
Leben an. Wenn Sie einen Platz auswählen, wird das Spiel ab der gespeicherten 
Ebene mit der Anzahl der Leben gestartet, die Ihnen zum Zeitpunkt des letzten 
Speichervorgangs zur Verfügung standen. Wenn Sie ein gespeichertes Spiel laden, 
beginnt Ihr Spielstand wieder bei Null. Um eine möglichst hohe Anzahl an Punkten 
zu erzielen, müssen Sie das Spiel in einem Durchgang spielen. Mit der Option Back 
können Sie jederzeit zum Hauptfenster zurückkehren.

Online
Mit der Option Online können Sie eine Verbindung zur Spiele-Homepage für den 
Nokia 9210 Communicator herstellen. Um auf das Internet zugreifen zu können, 
muss der Communicator entsprechend konfiguriert sein. Wenn Sie den Browser 
schließen, kehren Sie zum Hauptmenü von Bounce zurück. Die Homepage wird 
regelmäßig mit neuen Tipps und Tricks sowie News über die verschiedenen 
Spiele aktualisiert.
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eingeschaltet sein. Schalten Sie den Communicator nie ein, wenn die 
Benutzung von Mobiltelefonen verboten ist oder durch den 
Communicator Störungen verursacht werden bzw. gefährliche 
Situationen entstehen können.

Optionen
Das Menü Options enthält drei Optionen: Change Keys, Change Sound und Back. 
Mit der Option Change Keys können Sie die Steuertasten ändern; mit Change Sound 
können Sie die Lautstärke der Audioeffekte einstellen und mit der Option Back 
kehren Sie zum Hauptfenster zurück.

Spielstände
Mit der Option High Scores rufen Sie eine Liste der besten Ergebnisse auf, 
die Sie mit Bounce erzielt haben. Wählen Sie die Option Back, um zum 
Hauptfenster zurückzukehren.

Steuertasten
Mit den Pfeiltasten < und > können Sie den Ball nach links und rechts bewegen. 
Wenn Sie die Leertaste drücken, springt der Ball auf. Im Menü Optionskönnen Sie 
die Steuertasten ändern. Verwenden Sie hierzu die Option Change Keys.

Größe ändern
Ihr Ball ändert seine Größe, wenn er die richtigen Objekte berührt. Ein großer Ball 
springt höher und weiter als ein kleiner Ball und kann außerdem im Wasser 
schwimmen. Mit einem kleineren Ball kommen Sie durch kleine Lücken.
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MDemo
Das Spiel verfügt über viele verschiedene Funktionen. Um eine Demonstration der 
Spielfunktionen aufzurufen, wählen Sie im Menü Start Game den Befehl 
Instructions. Sie können die Demo jederzeit durch Drücken einer beliebigen 
Taste beenden.

Spiel anhalten
Durch Drücken auf die Escape-Taste oder auf eine beliebige Befehlstaste wird das 
Spiel angehalten. Wenn das Spiel angehalten ist, können Sie im Menü Options die 
Steuertasten neu definieren und die Lautstärke ändern. Sie können das Spiel auch 
beenden oder fortsetzen.

Zwischen den Ebenen
Nachdem Sie eine Ebene beendet haben, können Sie das Spiel speichern, 
die Optionen ändern und das Spiel beenden oder mit dem Spiel fortfahren. 
Wenn Sie ein Spiel speichern, wird eine Liste mit vier Speicherplätzen angezeigt, 
die die Nummern der Ebenen zuvor gespeicherter Spiele enthält. Über den Befehl 
Options wird die gleiche Liste wie über das Menü Options im Hauptfenster 
aufgerufen. Mit End game wird das aktuelle Spiel beendet, und Sie kehren zum 
Hauptfenster zurück. Mit der Option Continue rufen Sie die nächste Spielebene auf.

Spielende
Das Spiel ist zu Ende, wenn Sie alle verfügbaren Ebenen durchlaufen haben oder 
Ihnen kein weiteres Leben mehr zur Verfügung steht. Wenn Sie nach dem Ende des 
Spiels eine entsprechende Punktzahl erreicht haben, haben Sie die Möglichkeit 
Ihren Namen in die Liste der besten Spieler einzugeben.



©2001 Nokia Mobile Phones. All rights reserved. 

36
So

ft
w

ar
e 

au
f 

de
r 

CD
-R

O
M Triplepop

Triplepop ist ein schnelles Spiel, bei dem verschiedenfarbige Seifenblasen von der 
Seite in die Mitte des Displays fliegen und dort einen Ballen bilden. Durch Drehen 
des Ballens können Sie beeinflussen, wo die Seifenblasen landen. Sobald sich drei 
gleichfarbige Seifenblasen nebeneinander ansammeln, platzen sie! Wenn Sie nicht 
schnell genug sind, wächst der Ballen über das Maximum an, und Sie verlieren. 
Triplepop ist nur in Englisch verfügbar.

Abbildung 8

Anforderungen
Triplepop benötigt mindestens 1,5 MB Arbeitsspeicher und 800 KB 
freien Speicherplatz auf dem Nokia 9210 Communicator oder auf 
der Mini-Speicherkarte.

So starten Sie Triplepop:
1 Wählen Sie das Triplepop-Symbol mit den Pfeiltasten aus der Liste Extras aus, 

und drücken Sie auf Öffnen. 
2 Wenn das animierte Logo von Triplepop angezeigt wird, drücken Sie eine 

beliebige Taste, um das Hauptmenü zu aktivieren.
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M3 Mit den Pfeiltasten können Sie das gewünschte Menüelement markieren. 
Drücken Sie anschließend die Eingabetaste, um den Befehl auszuführen.

Hauptfenster
Das Menü des Hauptfensters enthält fünf Optionen: Start Game, Online, Options, 
High Scores und Quit. Um die Option Quit auszuwählen, drücken Sie die Pfeiltaste > 
und die Eingabetaste oder die unterste Befehlstaste.

Das Menü „Start Game“
Das Menü Start Game enthält vier Optionen: Mit den Optionen New Game, Change 
Skill, Instructions und Back. Mit der Option New Game wird ein neues Spiel auf der 
aktuellen Spielebene gestartet. Mit der Option Change Skill können Sie zum Fenster 
Skill Options wechseln. In diesem Fenster können Sie die Spielebene ändern. Mit der 
Option Instructions können Sie die Spielregeln anzeigen. Mit dem Befehl Back 
kehren Sie zum Hauptfenster zurück.

So ändern Sie die Spielebene:
Über das Menü Skill Options können Sie die drei möglichen Spielebenen 
(Easy, Medium und Hard) aufrufen. Außerdem können Sie über dieses Menü 
mit der Option Back zum Hauptfenster zurückkehren. Die aktuell ausgewählte 
Ebene wird hervorgehoben.

Online
Mit der Option Online können Sie eine Verbindung zur Spiele-Homepage für den 
Nokia 9210 Communicator herstellen. Um auf das Internet zugreifen zu können, 
muss der Communicator entsprechend konfiguriert sein. Wenn Sie den Browser 
schließen, kehren Sie zum Hauptmenü von Triplepop zurück.
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eingeschaltet sein. Schalten Sie den Communicator nie ein, wenn die 
Benutzung von Mobiltelefonen verboten ist bzw. durch den 
Communicator Störungen verursacht werden oder gefährliche 
Situationen entstehen können.

Optionen
Das Menü Options enthält drei Optionen: Change Sound, Change Keys und Back. Mit§ 
her Option Change Sound können Sie die Lautstärke von Audioeffekten regeln; 
mit der Option Change Keys können Sie die Steuertasten neu belegen und mit Back 
können Sie zum Hauptfenster zurückkehren.

Spielstände
Die Option High Scores ruft eine Liste der besten Ergebnisse auf, die Sie mit 
Triplepop erzielt haben. Wählen Sie Back, um zum Hauptfenster zurückzukehren.

Spielablauf
Sie steuern einen runden Ballen aus Seifenblasen, dessen Mitte ein schwarzer Stein 
bildet. Während des Spiels fliegen Seifenblasen von links und rechts auf den Ballen 
zu und bleiben daran kleben.

Mit den Pfeiltasten < und > kann der Ballen gedreht werden. Sie können mit ihnen 
steuern an welcher Stelle die Blasen auf den Ballen treffen. Wenn der Ballen eine 
bestimmte Größe erreicht hat, ist das Spiel beendet.
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MEs gibt rote, grüne, gelbe und blaue Seifenblasen. Blasenketten aus mindestens 
drei gleichfarbigen Blasen zerplatzen, wobei Sie für jede zerplatzte Seifenblase 
5 Punkte erzielen. Achten Sie später auf unbewegliche Seifenblasen. Ketten aus 
unbeweglichen Seifenblasen zerplatzen nicht von selbst. Sie zerplatzen nur wenn 
sie mit Blasen einer anderen Farbe in Berührung kommen.

Im Laufe der Zeit blinken die Seifenblasen im Ballen auf und verwandeln 
sich in Steine. Diese Steine können nur zerstört werden, indem Sie spezielle 
Bonus-Seifenblasen abfeuern.

Zu Beginn des Spiels verfügen Sie über keine Bonus-Seifenblasen. Sie können 
Bonus-Seifenblasen hinzugewinnen, indem Sie vier oder mehr Bälle auf einmal 
platzen lassen. Je länger die Kette, desto höher der Bonus. Während sich der 
Bonusstand erhöht, leuchten die Symbole auf und geben somit an, welche Bonus-
Seifenblase abgefeuert wird, wenn Sie auf die Taste <Abfeuern> drücken. Es gibt 
vier verschiedene Bonus-Seifenblasen, die jeweils eine unterschiedliche 
Auswirkung auf den Ballen haben.

Die Bonus-Seifenblasen können folgende Auswirkungen haben:
• Zerplatzen der Seifenblasen in der Nähe des Treffers
• Zerplatzen der Seifenblasen an der Ballenmitte
• Zerplatzen der Seifenblasen ringförmig in der Nähe des Treffers
• Zerplatzen aller Seifenblasen innerhalb und unterhalb des Treffers

Wenn Sie nach dem Ende des Spiels eine entsprechende Punktzahl erreicht haben, 
können Sie Ihren Namen in die Liste der besten Spieler eingeben.

Steuertasten
Folgende Steuertasten stehen standardmäßig zur Verfügung:
• Linke Pfeiltaste <
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• Abfeuern – Leertaste

So halten Sie das Spiel an:
Durch Drücken auf die Escape-Taste oder auf eine beliebige Befehlstaste wird das 
Spiel angehalten. Wenn das Spiel angehalten ist, können Sie über die 
Spieloptionen die Tastenbelegung neu definieren und die Lautstärke ändern. 
Sie können das Spiel auch beenden oder fortsetzen.

Card Deck
Die Solitaire-Kartenspiele sind wohl die bekanntesten und beliebtesten 
Kartenspiele. Card Deck für den Nokia 9210 Communicator bietet Ihnen 
interessante Unterhaltung und eine Reihe von Solitaire-Kartenspielen.

Abbildung 9

Anforderungen
Card Deck erfordert mindestens 1,2 MB Arbeitsspeicher und 400 KB Speicherplatz 
auf dem Nokia 9210 Communicator oder auf der Mini-Speicherkarte.
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1 Wählen Sie das Card Deck-Symbol mit den Pfeiltasten aus der Liste Extras aus, 

und drücken Sie auf Öffnen. 
2 Drücken Sie im Hauptfenster von Card Deck auf Play, und wählen Sie ein Spiel 

aus der Liste aus. Um die Spielregeln anzuzeigen, drücken Sie Strg+H.

Steuertasten
• Verwenden Sie die Pfeiltasten, um den Cursor zu bewegen.
• Um zwischen den verschiedenen Kartenspielen zu wechseln, drücken Sie die 

Pfeiltaste < oder >.
• Um innerhalb einen Kartenspiels zu navigieren, drücken Sie die Pfeil-nach-

unten- bzw. Pfeil-nach-oben-Taste.
• Um eine Karte aufzunehmen bzw. abzulegen, drücken Sie die Leertaste oder 

die Taste <Z>.
• Um neue Karten aufzulegen, drücken Sie die Eingabetaste.

Online
Besuchen Sie die Spiele-Homepage für den Nokia 9210 Communicator unter 
www.nokia.de/Spiele/92xx. Hier erhalten Sie Tipps und Tricks zu den 
verschiedenen Spielen.

Snake EX
Snake EX ist eine verbesserte Version des Spieleklassikers Nokia Snake für den 
Nokia 9210 Communicator.
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Abbildung 10

Anforderungen
Snake EX erfordert ca. 1,2 MB Speicherplatz und 650 KB freien Speicherplatz auf 
dem Nokia 9210 Communicator.

So starten Sie Snake EX:
1 Wählen Sie das Snake EX-Symbol mit den Pfeiltasten aus der Liste Extras aus, 

und drücken Sie auf Öffnen.
2 Drücken Sie im animierten Startfenster von Snake EX Settings und anschließend 

auf Mode, um die Einstellungen für die Steuertasten, die Schwierigkeitsstufen 
und Spieleranzahl auszuwählen. 

3 Drücken Sie auf Play, um ein neues Spiel zu starten.

Spielablauf
Lassen Sie die Schlange wachsen, indem Sie sie Futter aufnehmen lassen. 
Sie können die Schlange nicht anhalten oder rückwärts bewegen. Versuchen Sie 
die Begrenzungen oder den Schwanz der Schlange nicht zu berühren. 
Zusätzlich zum normalen Futter gibt es Powerfutter auf dem Spielfeld. 
Powerfutter kann das Spiel vorübergehend einfacher oder schwieriger gestalten. 



©2001 Nokia Mobile Phones. All rights reserved.

43

So
ft

w
ar

e 
au

f 
de

r 
CD

-R
O
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Welche Auswirkung das Powerfutter hat, finden Sie erst heraus, wenn die 
Schlange es gefressen hat.

Das Spiel verfügt über zwei Modi. Im klassischen Modus können Sie das Labyrinth 
und die Geschwindigkeit auswählen, mit der sich die Schlange fortbewegt. 
Im Extrem-Modus ändert sich bei Erreichen bestimmter Spielstände das Labyrinth.

Sie können Snake EX auch gegen einen Mitspieler spielen. Sie können entweder mit 
einem Gerät oder mit zwei über Infrarot verbundenen Geräten spielen.

Steuertaste und Zunge
Sie können die Schlange auf drei verschiedene Arten spielen:
• Unmittelbar mit Hilfe der Pfeiltasten
• Relativ – Verwenden Sie hierzu die Pfeiltasten < und >. Die Schlange bewegt 

sich in Uhrzeigersinn und gegen den Uhrzeigersinn.
• Diagonal – verwenden Sie die diagonalen Pfeile. Der obere linke Pfeil bewegt 

die Schlange beispielsweise nach oben oder nach links und der untere rechte 
Pfeil bewegt die Schlange nach unten oder nach rechts.

Die Schlange hat eine Zunge. Sie können diese verwenden, um Futter aus einiger 
Entfernung aufzunehmen. Verwenden Sie die Leertaste, um die Zunge zu steuern.

Schwierigkeitsstufen
Das Spiel verfügt über fünf Spielebenen unterschiedlicher Schwierigkeitsstufe. 
Auf der ersten Spielebene bewegt sich die Schlange nur langsam und ist leicht zu 
steuern. Auf einer höheren Spielstufe bewegt sich die Schlange schneller, aber bei 
der Aufnahme von Futter gibt es mehr Punkte.
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Im klassischen Modus können Sie das Labyrinth auswählen, in dem Sie das Spiel 
beginnen möchten. In den verschiedenen Labyrinthen gibt es unterschiedliche 
Arten von Futter und Powerfutter. Der Extrem-Modus beginnt im ersten Labyrinth 
und wird immer schwieriger: Bei Erreichen bestimmter Spielstände wird das Spiel 
jeweils in einem schwierigeren Labyrinth fortgesetzt.

Powerfutter
In dem Spiel gibt es sieben verschiedene Arten von Powerfutter. Die Aufnahme 
von Powerfutter kann das Spiel zeitweise einfacher oder schwieriger machen. 
Sie wissen nie im voraus, welche Auswirkung das Powerfutter hat.
• Foodfest: zusätzliches Futter erscheint auf dem Spielfeld.
• Invincibility: Die Schlange kann durch Wände und durch ihren eigenen 

Schwanz hindurchwandern, ohne zu sterben.
• Reducer: macht die Schlange kürzer. Der Effekt ist andauernd.
• Relax: verlangsamt die Schlange.
• Reverse: kehrt die Steuerbefehle um.
• Tongue: verdoppelt die Länge der Zunge.
• Turbo: erhöht die Geschwindigkeit der Schlange.

Andere
Schriftarten
Zusätzliche Schriftarten erhöhen die Anzahl von Zeichenstilen, die für den 
Communicator im Unterordner „Andere“ erhältlich sind.
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Wenn Sie die Anwendung „Rechtschreibprüfung“ auf dem Nokia 9210 
Communicator installieren, können Sie Wörter und Text in allen Anwendungen, 
in denen die Option Rechtschreibprüfung… verfügbar ist, z. B. in Word, auf korrekte 
Schreibweise überprüfen. Detaillierte Informationen über die Rechtschreibprüfung 
finden Sie im Benutzerhandbuch unter „So prüfen Sie die Rechtschreibung:“ auf 
Seite 35.

Hinweis: Die Rechtschreibprüfung steht nur für die englische Sprache 
zur Verfügung.
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